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Pos: 1 /TD/Überschriften/MUF/Sicherheit und Umwelt @ 3\mod_1234793958627_79.doc @ 26223 @ 1 
 

1 Safety and the environment 
Pos: 2 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Elektrische Gefahren vermeiden @ 3\mod_1234794609299_79.doc @ 26280 @ 5  

Avoiding electrical hazards 
> Never use the instrument and connected probes to measure on 

or near live parts! 
> Damaged mains cables must only be replaced by authorized 

personnel. 
> Only have the transmitter wired and connected by authorized 

personnel with the voltage disconnected. 
> You must always comply with the regulations applicable in your 

country for opening and repairing electrical equipment. 
Pos: 3 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Personen- und Sachschäden vermeiden @ 3\mod_1234794744768_79.doc @ 26299 @ 5 
 

Avoiding personal injury and damage to equipment 
> Installation, setting and calibration work must only be carried 

out by qualified and authorized personnel! 
> Only open the instrument when this is expressly described in 

the instruction manual for installation, maintenance or repair 
purposes. 

> Observe the permissible storage, transport and operating 
temperature. 

Pos: 4 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nicht mit Lösungsmitteln lagern @ 0\mod_1175692375179_79.doc @ 583 @  
 

> Do not store the product together with solvents. Do not use any 
desiccants. 

Pos: 5 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Bei Wartung MUF nicht zur Regelung verwenden @ 3\mod_1234794852377_79.doc @ 26318 @  
 

> Do not use the instrument for control purposes at the same time 
as operating or servicing the transmitter. 

Pos: 6 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Produkt bestimmungsgemäß verwenden @ 0\mod_1173781261848_79.doc @ 386 @  
 

> Only operate the product properly, for its intended purpose and 
within the parameters specified in the technical data. Do not 
use any force. 

Pos: 7 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nur beschriebene Wartungsarbeiten durchführen @ 0\mod_1175692705195_79.doc @ 601 @  
 

> Carry out only the maintenance and repair work on this 
instrument that is described in the documentation. Follow the 
prescribed steps exactly. Use only original spare parts from 
Testo.  

Pos: 8 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Fachpersonal @ 3\mod_1234794940409_79.doc @ 26337 @  
 

Any additional work must only be carried out by authorized 
personnel. Otherwise testo will not accept any responsibility for the 
proper functioning of the instrument after repair and for the validity 
of certifications. 
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Pos: 9 /TD/Überschriften/MUF/Umwelt schützen @ 3\mod_1234858757571_79.doc @ 26363 @ 5 
 

Protecting the environment 
Pos: 10 /TD/Sicherheit und Umwelt/Umwelt schützen/Produkt entsorgen @ 0\mod_1173780307072_79.doc @ 357 @   

> At the end of its useful life, send the product to the separate 
collection for electric and electronic devices (observe local 
regulations) or return the product to Testo for disposal.  

Pos: 11 /TD/Überschriften/MUF/Zu diesem Dokument @ 3\mod_1234793991331_79.doc @ 26242 @ 1 
 

2 About this document 
Pos: 12 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Verwendung (Standard) @ 0\mod_1173775068554_79.doc @ 337 @ 5 
 

Use 
> Please read this documentation through carefully and 

familiarize yourself with the product before putting it to use. Pay 
particular attention to the safety instructions and warning advice 
in order to prevent injuries and damage to the products. 

> Keep this document to hand so that you can refer to it when 
necessary.  

> Hand this documentation on to any subsequent users of the 
product. 

Pos: 13 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis WARNUNG @ 2\mod_1207646966234_79.doc @ 14398 @   

 WARNING Indicates potential serious injuries 
 Pos: 14 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis VORSICHT @ 2\mod_1207651416515_79.doc @ 14416 @  
 

 CAUTION indicates potential minor injuries 
 
Pos: 15 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonv. Software [Standard] @ 0\mod_1190203332543_79.doc @ 4883 @ 5  

Symbols and writing standards 
 

Representa-
tion  

Explanation  

 
Note: Basic or further information. 

1. ... 
2. ... 

Action: more steps, the sequence must be 
followed. 

> ... Action: a step or an optional step. 
- ... Result of an action. 
Menu Elements of the program interface. 
[OK] Buttons of the program interface.  
... | ... Functions/paths within a menu. 
“...” Example entries 

 
Pos: 16 /TD/--- Seitenwechsel --- @ 0\mod_1173774430601_0.doc @ 283 @  
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Pos: 17 /TD/Überschriften/MUF/Inhalt @ 3\mod_1234794019831_79.doc @ 26261 @ 1  
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Pos: 19 /TD/Überschriften/MUF/1 Messumformer @ 3\mod_1234258401060_79.doc @ 23894 @ 1  

4 Transmitter 
Pos: 20 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

4.1. Specifications 
Pos: 21 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 6781 @ 3\mod_1238162232871_79.doc @ 30254 @ 3 
 

4.1.1. Functions and use 
The testo 6781 transmitter was developed especially for low 
dewpoint temperatures and is suitable for the following 
applications, amongst others: 
• Compressed air process engineering 
• Clean-room technology  
• Regulation and monitoring of compressed air driers 
•  Production and conveyance of gases 
• Monitoring of humidity and temperature in medical compressed 

air or granulate driers 
Pos: 22 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 6781 @ 3\mod_1238162497483_79.doc @ 30275 @ 3 
 

4.1.2. Scope of delivery 
The scope of delivery of the testo 6781 transmitter includes the 
following: 
•  Assembly accessories 
• Operating instructions 
• Calibration report 
• CD-ROM with operating instructions (PDF) and P2A update 

(this can only be used in conjunction with the P2A software, 
which has to be ordered separately). 

Pos: 23 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/Zubehör Übersicht 635x @ 3\mod_1236084601953_79.doc @ 27292 @ 3 
 

4.1.3. Accessories 
The following accessories are available for the testo 6781 
transmitter, amongst others: 
•  Mains unit 
• P2A software (parameterizing, adjusting and analyzing 

software) 
• Assembly accessories 

 

 
Information about accessories and their order numbers can 
be found in Accessories and spare parts or on the 
website at www.testo.com. 
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Pos: 24 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 6781 @ 3\mod_1238162594608_79.doc @ 30296 @ 35555555555555555555555555  

4.1.4. Technical data 
Parameter 
• Dewpoint temperature1 

Measuring range at 25 °C 
• -90 to 30 °Ctd 

Meas. uncertainty2 
-20 °Ctd to -40 °Ctd: +/-1,5 K 
-40 °Ctd to -60 °Ctd: +/-2 K 
-60 °Ctd to -75 °Ctd: +/-2,5 K3 

 

 
The measuring uncertainty increases with high flow values.

                                                           
1 Above 0 °Ctd the dewpoint temperature is shown and below 0 °Ctd the frost 
point temperature is shown. In rare cases at frost point temperatures between 
-35 °Ctd and 0 °Ctd differences between the 6781 and a dew mirror hygrometer 
may occur. 
2 Expanded basic uncertainty (K = 2) at a process temperature of 25 °C. 
Measuring uncertainty according to GUM (Guide to the Expression of Uncertainty in Measurement): 
ISO guideline for determining the measuring uncertainty in order to render global measurement results 
comparable.  

The following uncertainties are used during the inquiry: 

• Hysteresis 

• Linearity 

• Reproducibility 

• Adjustment area/factory calibration 

• Test location 

An additional uncertainty factor independent of the dewpoint temperature and 
process of ±0.03 K x reading (in °Ctd) + 0.2 K x (25 °C - process temperature in 
°C) results from this overall view 
Outside the stated range, a measurement inaccuracy of +/-5K (typically) applies. 
3 At process temperatures > 25 °C the lower limit of the measuring range 
increases by 0.5 K/K. The uncertainty values are valid for the respective 
measuring range. 



4 Transmitter 

10 

 
  
 
 

Response time 
t63 ≤ 3 s when changing from -75 °Ctd to -30 °Ctd 
t90 ≤ 9 s when changing from -75 °Ctd to -30 °Ctd 
t63 ≤ 300 s when changing from -30 °Ctd to -75 °Ctd 

t90 ≤ 1080 s when changing from -30 °Ctd to -75 °Ctd 

Resolution 
Measuring range  Resolution 
0 to 100 % RH 0.001 
0.001 to 28 g/kg 0.001 
0.01 to 194 gr/lb 0.01 
0 to 31 g/m3 0.001 
0.001 to 14 gr/ft3 0.001 
1 to 42,500 ppm (vol) 1 
-90 to 30 °Ctd 0.1 
-130 to 86 °Ftd 0.1 
-110 to 30 °CtdA 0.1 
-165 to 86 °FtdA 0.1 
-40 to 70 °C 0.01 
-40 to 158 °F 0.01 

Meas. cycle 
• 1/sec 

Interface 
• Mini-DIN for P2A software (adjustment and parameterization 

software)  

Voltage supply 
•  4-wire (separate signal and supply lines): 20 to 30 V AC/DC, 

300 mA power consumption 
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Maximum load 
• 4-wire: 500 Ω (power output) 

 

 

Maximal load 
• 4-wire: 10 kΩ (voltage output) 

Analog output 
•  0 to 1 V ± 1.5 mV (4-wire) or 
• 0 to 5 V ± 7.5 mV (4-wire) or 
• 0 to 10 V ± 15 mV (4-wire) or 
• 0 to 20 mA ± 0.03 mA (4-wire) or 
• 4 to 20 mA ± 0.03 mA (4-wire) 

Resolution of analog output 
• 12 bit 

Display 
• 2-line LCD with plain text line (optional) 

Operating temperature without display 
• -40 to 70 °C 

Operating temperature with display 
• 0 to 50 °C 
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Storage temperature without display 
• -40 to 80 °C 

Storage temperature with display 
• -20 to 80 °C 

Process temperature 
• -40 to 70 °C 

Application humidity 
• 0 to 100 % RH 

Pressure application range 
• 50,000 hPa 

Housing, weight 
• Metal, 0.5 kg 

Process connection 
• G 1/2 or 
• NPT 1/2" 

Protection class 
• IP 65 only if the transmitter is wired and/or sealing plugs are 

inserted 

Directives, standards and tests 
• EC Directive: 2004/108/EC 
• 6781 was manufactured in accordance with EC pressure 

equipment Directive 97/23/EC, Article 3 Paragraph 3 as per 
"sound engineering practice", taking the regulations to be 
observed into account. 

Warranty 
• Duration: 2 years 
• Warranty conditions: see website www.testo.com/warranty 
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Pos: 25 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 6781 Abmessungen @ 3\mod_1239806330094_79.doc @ 31183 @ 3 
 

4.1.5. Dimensions 
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 Pos: 26 /TD/Überschriften/MUF/1.2/2.2 Produktbeschreibung @ 3\mod_1234258723551_79.doc @ 24008 @ 2 
 

4.2. Product description 
Pos: 27 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Systemkomponenten 6781 @ 3\mod_1239868226476_79.doc @ 31305 @ 3 
 

4.2.1. System components 
 

 

 

Application  System components  
A  With clean air and a process pressure 

corresponding to the presetting of the 
measurement chamber (1), a measurement 
chamber (1) is required for the rapid 
assembly (without de-pressurizing the 
installation). 

• 1: Measurement chamber 
• testo 6781 with 

G1/2 thread 

B  With clean air and a process pressure 
greater than or less than 7000 hPa (1000 to 
35,000 hPa) that therefore does not 
correspond to the presetting of the inflow 
valve, a measurement chamber (1) with a 
flow meter (2) is required. 

• 1: Measurement chamber 
• 2: Flow meter 
• testo 6781 with 

G1/2 thread 
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Application  System components  
C For rapid assembly (without de-pressurizing 

the installation), a measurement chamber (1) 
is required. Connect a filter (4) upstream for 
oily media. 

• 4: Filter 
• 1: Measurement chamber
• testo 6781 with 

G1/2 thread 
D With dry air (max. 140 °C), a PTFE tube (3) 

is used and the valve of the measurement 
chamber (1) is opened to maximum (suitable 
up to -60 °Ctd). 

• 3: PTFE tube 
• 1: Measurement chamber
• testo 6781 with 

G1/2 thread 
E For process temperatures of 50 °C to 200 °C 

and a process pressure corresponding to the 
presetting, it is necessary to use a cooling 
coil (5) and a measurement chamber (1). 
Connect a filter upstream for oily media. 

• Filter, if necessary 
• 5: Cooling coil  
• 1: Measurement chamber
• testo 6781 with 

G1/2 thread 
F If A to E are not required. The thread is 

screwed directly into the process. 
De-pressurized tube required during 
installation.  

• testo 6781 with 
G1/2 thread  

or 
• testo 6781 with N1/2" 

thread 
 
Pos: 28 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Auf einen Blick MUF 6781 @ 3\mod_1238165303035_79.doc @ 30317 @ 3 
 

4.2.2. At a glance 
 

1 Display (optional) 
2 Keys (only with optional display)
3 Test contacts  
4 M 16 x 1.5 screw connection, 

e.g. analog output  
5 Service flap with connection for 

service plug 
6 Screw connection with process 

connection (G 1/2 or NPT 1/2") 
7 Sintered cap over sensor unit 

 



4 Transmitter 

16 

Pos: 29 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Display und Tastatur 6781 @ 4\mod_1250064749770_79.doc @ 47423 @ 3 
 

4.2.3. Display and keypad 
The display option allows operation of the testo 6781 transmitter via 
the display and four keys. 
The LCD display consists of one 7-segment line for displaying 
readings and units and of an information line (for status messages, 
for example). 
The brightness and contrast of the display and the background 
lighting (permanent or off) can be changed via the user menu or the 
P2A software. 

Pos: 30 /TD/Überschriften/MUF/1.2.x Serviceschnittstelle @ 3\mod_1237306891654_79.doc @ 29795 @ 3 
 

4.2.4. Service interface 
Pos: 31 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Serviceschnittstelle 635x @ 3\mod_1237217388492_79.doc @ 29723 @  
 

The parameterizing socket (mini-DIN) is located behind the service 
flap as an interface to the P2A software. 

Pos: 32 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Analogausgänge 635x @ 3\mod_1234774510463_79.doc @ 25726 @ 3 
 

4.2.5. Analog outputs 
As analog outputs, the testo 6781 has either 
• 1 current output of 0 to 20 mA (4-wire)/4 to 20 mA (4-wire) or 
• 1 voltage output of 0 to 1 V/0 to 5 V/0 to 10 V (4-wire) 

 
 Pos: 33 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Messgrößen 6781 @ 3\mod_1239284685066_79.doc @ 31095 @ 3 
 

4.2.6. Parameters 
The following parameters are displayed: 
• Relative humidity in % RH (technical) 
• Degree of humidity in g/kg and gr/lb  
• Absolute humidity in g/m³ and gr/ft³ 
• Water content in ppm (vol) 
• Dewpoint temperature in °Ctd and °Ftd 
• Standardized dewpoint (at atmospheric pressure 1013 hPa) in 

°CtdA and °FtdA 

• Temperature °C and °F 
Pos: 34 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Skalierung @ 3\mod_1234775406989_79.doc @ 25783 @ 3  

4.2.7. Scaling 
There are three types of min./max. values: 
1 The measuring range: The maximum sensor performance is in 

this range. Values outside of the measuring range are displayed 
via messages, for example.  
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2 Standard scaling: The output signals are assigned to this 
measuring range as standard: 
◦ during delivery if no entries are made in the order code 
◦ after exchanging the unit, the measuring range recorded in 

the instrument is applied as standard. 
 

 
The transmitter even retains its scaling with the voltage 
disconnected. 

 

3 The maximum settings for the manual scaling  
◦ The maximum limits can be calculated as follows: 
 X = difference between MIN. and MAX. value of the 

standard scaling 
 (Max. value of standard) + (50 % of X) 
 (Min. value of standard) - (50 % of X) 
◦ It is thus possible to scale beyond the measuring range, e.g. 

for the adjustment of the scaling limits to standard values of 
a PLC. 

With the alarm definition, however, the physical measuring 
range limits are decisive. 

 
 Pos: 35 /TD/Überschriften/MUF/1.3/2.3 Inbetriebnahme @ 3\mod_1234258805768_79.doc @ 24027 @ 2 
 

4.3. Commissioning 
Pos: 36 /TD/Erste Schritte/MUF 63xx/Mechanische Montage 6781 @ 3\mod_1239807163104_79.doc @ 31204 @ 3444 
 

4.3.1. Mechanical assembly 
 

 
• Carefully perform assembly work. 
• Take special care with leaktightness. We recommend 

inserting a metal sealing ring (internal diameter 21 mm).
• Do not use any hygroscopic materials for the sealing. 

 

> Only use force on the union nut. 
Depending on the application, there are three different assembly 
options: 

 

Assembly  Application  
Without stainless steel 
measurement chamber 
and cooling coil 

• Process temperatures 0 to 50 °C 
• Attachment of the sensor directly in 

the process possible 
• No fast assembly/dismantling of the 

testo 6781 required and sufficient 
inflow of the sensor (1 l/min.) exists 
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Assembly  Application  
With stainless steel 
measurement chamber 

• Process temperatures 0 to 50 °C 
• Fast assembly/dismantling of the 

testo 6781 required and/or 
• No sufficient inflow of the sensor 

(1 l/min.) exists 
With stainless steel 
measurement chamber 
and cooling coil 

• Process temperatures 50 to 200 °C 

 

4.3.1.1. Without stainless steel measurement chamber and cooling 
coil 
 

CAUTION
Compressed air! Danger of injury! 
> De-pressurize pipe sections (e.g. compressor off or use of 

bypass) and vent them before opening. 
 

 

 
Clamp ring screw connection is already pre-assembled. 
Screw connection body (1) and union nut (2) have a point-
shaped marking (4). 

 

 
1. Screw thread in process. 
2. Turn housing (3) to desired position without much exertion 

of energy. 
3. Tighten union nut (2) finger-tight. 
4. Hold screw connection body (1) with a suitable spanner. 
5. Tighten union nut (2) slightly past the marking (4). 

 

 
An increased resistance can be felt when tightening. 
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6. Close ventilation of the pipe section and pressurize the pipe 
section again. 

4.3.1.2. With stainless steel measurement chamber (max. 35,000 hPa) 
1. Connect measurement chamber without testo 6781 transmitter 

to quick-release compressed-air fastener for approx. 10 - 30 
sec. to blow out any dirt deposits. 

2. Remove measurement chamber from quick-release 
compressed-air fastener. 

3. Screw process connection (G1/2) of the testo 6781 transmitter 
into the thread of the measurement chamber. 

4. Mount 6781 as described under Without stainless steel 
measurement chamber and cooling coil page 18. 

5. Engage quick-release fastening of the measurement chamber 
in the standardized socket of the compressed air line. 

4.3.1.3. With stainless steel measurement chamber and cooling coil  
(max. 35,000 hPa) 
1. Connect measurement chamber without testo 6781 transmitter 

to quick-release compressed-air fastener for approx. 10 - 30 
sec. to blow out any dirt deposits. 

2. Remove measurement chamber from quick-release 
compressed-air fastener. 

3. Screw process connection (G1/2) of the testo 6781 transmitter 
into the thread of the measurement chamber. 

4. Mount 6781 as described under Without stainless steel 
measurement chamber and cooling coil page 18. 

5. Engage quick-release fastening of the measurement chamber 
in quick-release fastening of the cooling coil. 

6. Engage second quick-release fastening of the cooling coil in the 
standardized socket of the compressed air line. 
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Pos: 37 /TD/Erste Schritte/MUF 63xx/Spannungsversorgung/Analogausgänge anschließen 6781 @ 3\mod_1239951683334_79.doc @ 31673 @ 45 
 

4.3.1.4. Connecting voltage supply and analog outputs 
 
 
 

Wiring diagram for 4-wire system (0 to 20 mA/4 to 20 mA/0 to 
1 V/0 to 5 V/0 to 10 V) 

1-channel 
0 to 20 mA/4 to 20 mA 
max. load per 500 Ω 
0 to 1 V/0 to 5 V/0 to 
10 V 

  
 

 
Requirement for the connecting cable of the supply: 
• Shielded and insulated with cross-section of at least 

0.25 mm2. 
• The supply line must be secured against exceeding 8 A. 
• An OFF switch must be installed in an easily accessible 

position close by and be marked as such. 
 

Pos: 38 /TD/Erste Schritte/MUF 63xx/Option Steckerverbindung 6781 @ 3\mod_1239951744567_79.doc @ 31694 @ 4 
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4.3.1.5. Plug-in connection for power supply and channel 
M12 plug-in connection (5-pin) connector 
View of the plug-in connection in the installed state from outside 

 

PIN Assignment 
1 -24 V  
2 +24 V 
3 + Ch1 
4 - Ch1 

 5 PE 
 Pos: 39 /TD/Überschriften/MUF/1.3.3 Gerät abgleichen @ 3\mod_1236081099337_79.doc @ 27173 @ 3 
 

4.3.2. Adjusting the instrument 
Pos: 40 /TD/Erste Schritte/MUF 63xx/1-Punkt-Abgleich 6781 @ 3\mod_1239794807174_79.doc @ 31163 @ 44  

4.3.2.1. Self-adjustment 
Conventional trace humidity sensors show a steep rise in 
measuring uncertainty at low humidities. With the trace humidity 
sensor of the testo 6781, these measuring uncertainties are 
corrected by means of an automatic self-adjustment process. This 
means that extremely accurate measuring results are also attained 
in the range up to -90 °Ctd. 
To this end, a temperature sensor which is used as a heater is 
fitted on the back of the sensor element. A humidity and 
temperature value pair is taken in both the unheated and heated 
state. The deviation of the probe obtained from these pairs of 
values is automatically corrected. 
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• Deactivating the self-adjustment function of the testo 

6781 will reduce measuring accuracy and should 
therefore be restricted to the shortest possible length of 
time. 

• During the self-adjustment phase, the analog outputs, 
the display value and the output value are "frozen". 
Self-adjustment active is shown in the display until it 
has finished. The self-adjustment time (incl. heating 
time, calculation time, cooling time) is 30 minutes. The 
cycle time can be edited in the P2A software, see Self-
adjustment page 54. 

• At temperature wn > 0 °C, the self-adjustment time 
becomes longer. 

 

4.3.2.2. 1-point adjustment by entering a reference value 
Using the 1-point adjustment, you can enter a reference value for 
one of the working points you have selected (e.g. -40 °Ctd). With 
this, you achieve a minimum target/actual deviation around this 
working point.  
But the further away the measurement is from the working point, 
the greater the deviation can become. The 1-point adjustment 
should therefore only be used for a relatively narrow measuring 
range (working range) 

 
 

✓   A reference measuring instrument (e.g. dewpoint mirror 
hygrometer) is ready. 

1. Expose the reference measuring instrument and testo 6781 to 
the same constant conditions and wait for the equalization 
period to expire. 

 
The ideal accuracy is reached when at least two adjustment 
cycles are run through at dewpoint temperatures above -60 
°Ctd, whereby four adjustment cycles are recommended at 
dewpoint temperatures below -60 °Ctd. 

2. Measure the reference value and compare with the reading of 
the testo 6781. 

3. In the event of deviations of the values: Enter reference value 
• via the user menu (see Enter reference value for 1-point 

adjustment page 35) or 
• via the P2A software (see 1-point adjustment page 61). 
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Pos: 41 /TD/Erste Schritte/MUF 63xx/Analogausgangs-Abgleich _6781 @ 3\mod_1241426437080_79.doc @ 32365 @ 45 
 

4.3.2.3. Analog output adjustment 
The purpose of adjusting the analog outputs is to adjust the signal 
chain from the digital signal (within the transmitter) to the analog 
outputs. The signal type that was appointed for the transmitter is 
adjusted respectively for each channel (e.g. 4 to 20 mA or 0 to 1 V, 
etc.). 

 

1 Contact ch. 1+ 
2. Contact ch. 1- 
3. Service interface 

Adjusting the analog output 

✓  Load of max. 500 Ω is connected to channel 1 (see Plug-in 
connection for power supply and channel page 21) 

✓  A precise multimeter (minimum requirement: resolution 6.5 
digits, at least 5-times more accurate than the 6781) is 
available. 

 

 
If only a simple multimeter is available, the analog outputs 
may not be adjusted.  

 

1. Connect the inputs of the multimeter with the contacts (1) and 
(2) for channel 1. 

2. Transfer the reference analog value measured with the 
multimeter into the P2A software (see Adjusting the analog 
output page 62) or enter it via the user menu (see Performing 
analog adjustment page 36). 

3. Disconnect connections between the multimeter and the 
contacts of the testo 6781. 

Pos: 42 /TD/Überschriften/MUF/1.4 Bedienung @ 3\mod_1234443160034_79.doc @ 25001 @ 2 
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4.4. Operation 
Pos: 43 /TD/Produkt verwenden/MUF 63xx/Zusammenhang Bedienmenü – Mini DIN Buchse aktiv @ 3\mod_1234454016014_79.doc @ 25213 @ 3 
 

4.4.1. Relationship between user menu and mini-DIN 
socket is active 
The testo 6781 can be parameterized using either the user menu or 
the P2A software (see Parameterizing, adjusting and analyzing 
software (P2A software) page 42). 

 

 
The testo 6781 transmitter can only be operated via the 
display and keypad if the display option is available. 
If the testo 6781 is connected to the P2A software, the user 
menu is blocked for the duration of the communication. The 
message Service plug is shown in the display of the testo 
6781. As soon as the P2A software is disconnected, the 
user menu is accessible again. 

 Pos: 44 /TD/Produkt verwenden/MUF 63xx/Passwortschutz _6781 @ 3\mod_1241422238033_79.doc @ 32323 @ 3 
 

4.4.2. Password protection 
The user menu can be protected with a four-digit numerical code 
(see Calling up Main Menu  page 35) so that access to the user 
menu is denied to unauthorized persons not familiar with this 
numerical code. 
If the password protection is not to be used, the numerical code 
"0000" must be entered. This is also the status upon delivery. 

Pos: 45 /TD/Produkt verwenden/MUF 63xx/Aufbau des Bedienmenüs 6781 @ 3\mod_1239692809877_79.doc @ 31123 @ 3 
 

4.4.3. Structure of user menu 
At the main menu level, the user menu comprises the following: 
• Main Menu Channel 1 
•  Main Menu Alarm 
• Main Menu Settings 
• Main Menu Analysis 
• Main Menu Messages 
• Main Menu Ident 
• Main Menu Adjust 
• Main Menu Reset 
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1 Display for messages  
2 Channel 1 display 

 

Four keys enable the user to navigate/scroll through the menus and 
enter/amend values and settings: 

 

Key  Function/description 
SET • In Measuring Mode: changes to 

parameterization 
• In Parameterizing Mode: confirms a 

selection or setting 
ESC • Leaves a menu (without modifying any 

settings) 
 • Selecting: scrolls through menus 

(downwards) or selectable alternatives 
• Editing: changes to next digit (to the right) 

 • Selecting: scrolls through menus (upwards) 
or selectable alternatives 

• Editing: increases the value of the current 
digit by 1 
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Pos: 46 /TD/Produkt verwenden/MUF 63xx/Übersicht Bedienmenü @ 3\mod_1234510821302_79.doc @ 25303 @ 3  

4.4.4. Overview of the testo 6781 user menu 
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Pos: 47 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Kanäle bearbeiten @ 3\mod_1234511119158_79.doc @ 25322 @ 34 
 

4.4.5. The individual main menus 
4.4.5.1. Editing main menu of channel 1 

An overview is given in Overview of the testo 6781 user menu, 
page 26). 
You can perform basic settings for channel 1. 
1. In the Measuring Mode press SET, select Main Menu 

Channel 1 with  or  and confirm selection with SET. 
One of the following parameters can now be selected using  
or , after which the selection must be confirmed with SET: 

• Channel 1 Unit 
The parameter for this channel is selected. 
Edit/select parameter with  or , confirm with SET or abort 
entry with ESC. 

• Scale minimum for channel 1: 
The lower scale limit is edited; Unit as selected above. 
Editing the value: Scroll one digit to the right using  and 
increase value of digit by 1 using . Confirm with SET or abort 
entry with ESC. 

• Scale maximum for channel 1 
The upper scale limit is edited; 
Unit as selected above. 
Editing the value: Scroll one digit to the right using  and 
increase value of digit by 1 using . Confirm with SET or abort 
entry with ESC. 

• Signal delay ("Attenuation") for channel 1 
The analog signal can be delayed ("Attenuation"); a time 
constant is selected for this (1 = no delay; 15 = longest delay) 
Edit/select parameter with  or , confirm with SET or abort 
entry with ESC. 

2. Continue to the main menu with  or  or return to Measuring 
Mode with ESC. 

Pos: 48 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Alarm bearbeiten 6781 @ 4\mod_1244645622570_79.doc @ 44953 @ 455 
 



4 Transmitter 

  29 

4.4.5.2. Editing Main Menu Alarm 
The alarm statuses are shown on the display. You can choose 
whether the alarm is to be used to monitor limit values or as a 
collective alarm. If an alarm is to be used to monitor limit values, 
you can choose between monitoring the minimum or maximum 
value and set a limit value and hysteresis for each alarm.  
In addition, every alarm can be linked to a clearly visible visual 
alarm (display background lighting flashes). 
An alarm delay between 0 and 240 seconds can still be assigned to 
every alarm used for limit value monitoring so that the visual alarm 
is delayed. If the alarm status goes out within the set alarm delay 
time, the visual alarm is not triggered. . 
With an alarm status present, the visual alarm can be reset by 
means of acknowledgement. The triggering of a new alarm cannot 
be enabled until after the alarm status goes out.  
1. In the Measuring Mode press SET, select Main Menu Alarm 

with  or  and confirm selection with SET. 
- Four alarms can be parameterized. 
2. Select Alarm x with  or  and confirm selection with SET. 

Using alarm to monitor limit values 
 

Monitoring minimum Monitoring maximum 
Hysteresis  Hysteresis 

 
Limit value Limit value  

3. Select Channel x (e.g. "Channel 1") with  or  and confirm 
selection with SET. 

4. Select Max control or Min control with  or  (see graphic). 
5. Press SET and edit Limit value as well as Hysteresis: Scroll 

one digit to the right using  and increase value of digit by 1 
using . Confirm with SET or abort entry with ESC. 

6. Select Visual alarm with  or . Select YES or NO with  or 
. Confirm with SET or abort entry with ESC. 

7. Press SET and edit Alarm delay: Scroll one digit to the right 
using  and increase value of digit by 1 using . Confirm with 
SET or abort entry with ESC. 

8. Return to Channel x with ESC. 
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9. Return to Alarm x with ESC. 
10.  Change to the other alarms using  or  and perform settings 

in the same way. 

Using alarm as collective alarm or not using it at all 
If an alarm is assigned to the collective alarm, the display flashes 
as soon as (at least) one of the warning or error messages of the 
testo 6781 transmitter becomes active. 

 

 
The messages affecting the collective alarm can only be 
selected in the P2A software, see Using the software page 
46 

 

✓  Alarm is selected (see previous steps 1 and 2). 

1.  Use  or  to determine whether Alarm x should be used as a 
Collective alarm or not used. Confirm selection with SET.  

2. If collective alarm is selected: Select Visual alarm with  or . 
Select YES or NO with  or . Confirm with SET and return to 
Alarm x. 

3. Change to another alarm using  or  and perform settings in 
the same way. 

4. Return to Main Menu Alarm with ESC. 
5. Continue to Main Menu Settings with  or  or return to 

Measuring Mode with ESC. 
Pos: 49 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Einstellungen bearbeiten 6781 @ 4\mod_1244535897708_79.doc @ 44917 @ 45555  

4.4.5.3. Editing Main Menu Settings 
You can edit instrument settings and other settings. 
> In Measuring Mode, press SET, select Main Menu Settings 

using  or  and confirm selection with SET. 
You can edit settings for: 
• Display 
• Language 
• Code  
• Unit 

◦ Absolute pressure 
◦ Temperature 

• Humidity process data 
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Editing display settings 
You can set the brightness and contrast of the display. 
1. Select Display Settings with  or  and confirm selection with 

SET. 
2. Select Backlight or Contrast with  or  and confirm 

selection with SET. 
One of the following parameters can now be selected using  or 

, after which the selection must be confirmed with SET: 
• Backlight 

The display illumination is changed. 
Edit/select parameter with  or , confirm with SET or cancel 
entry with ESC (the effect of the change in parameter can be 
seen during input). 

• Contrast 
The brightness difference between the display background and 
the displayed values is changed. 
Edit/select parameter with  or , confirm with SET or cancel 
entry with ESC (the effect of the change in parameter can be 
seen during input). 

• Backlight 24h on 
Select On or Off using  or  and confirm with SET. 
Off: The display light switches off automatically if no button was 
pressed for 10 seconds. 
On: The display light is activated 

3. Return to Display Settings with ESC and use  or  to 
continue to Language. 

Selecting language 
You can select the language for the plain text line in the display. 
> Press SET, select required language with  or , confirm 

selection with SET and return to Language. 
 

 
Only choose a language that you can understand well. 
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Editing code settings 
You can set the access code (password). 

 

 
If a code other than "0000" (factory setting) is set, the 
transmitter can only be operated once this code has been 
entered via the menu. 

 

1. Select Code with  or  and confirm selection with SET. 
2. Scroll one digit to the right using  and increase value of digit 

by 1 using . Confirm with SET or abort entry with ESC. 
3. Return to Code with ESC and use  or  to continue to 

Change parameters. 

Select unit  
This setting affects the unit of the process data. 
1. Press SET, select Change parameters with  or , confirm 

selection with SET or cancel with ESC. 
2. Select Change unit with  or , confirm selection with SET or 

cancel with ESC. 
3. Select the required variable (absolute pressure/temperature) 

with  or , confirm selection with SET or cancel with ESC. 
4. Select the required unit with  or , confirm selection with SET 

or cancel with ESC. 
5 Return to Change unit with ESC.  
6. Select Humidity process data with  or , confirm selection 

with SET or cancel with ESC. 
7. Select Humidity process pressure with  or , confirm 

selection with SET or cancel with ESC. 
8. Scroll one digit to the right using  and increase value of digit 

by 1 using . Confirm with SET or abort entry with ESC. 
9. Return to Main Menu Settings by pressing ESC three times. 

Pos: 50 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Analyse bearbeiten 6781 @ 3\mod_1241425854399_79.doc @ 32344 @ 455 
 

4.4.5.4. Editing Main Menu Analysis 
You can check the function of analog outputs. In addition, you can 
read off the minimum and maximum values (since the last voltage 
supply or reset of the min./max. values). 

Testing functionality of analog outputs 
 

 
This function affects the analog outputs directly, not only 
the test contacts. 
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1. In the Measuring Mode press SET, select Main Menu Analysis 
with  or  and confirm selection with SET. 

- Test Analog Output is shown. 
2.  Press SET, scroll one digit to the right using  and increase 

value of digit by 1 using . Any analog output value can be 
predefined, e.g. for an analog output of 4 to 20 mA, the value 
"6.0 mA". Confirm with SET or abort entry with ESC. 

3. Accept setting by pressing SET and test with multimeter 
(minimum requirement: resolution 6.5 digits, at least 2-times 
more accurate than the 6781) as follows: 
Analog output 1: Via test contacts under service flap, see 
diagram. 

 

1 Channel 1 
test contacts 

2 Multimeter 

 

3. Return to Test Analog Output with ESC and continue to 
Max./min. values with  or . 

Reading off min./max. values of channels 
To reset the max./min. values, see Editing Reset main menu page 
37  
1. Read off the min./max. values of the channel in succession with 

 or  and return to the Main Menu Analysis with ESC. 
2. Continue to Main Menu Message with  or  or return to 

Measuring Mode with ESC. 
Pos: 51 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Meldungen bearbeiten 6781 @ 3\mod_1240905240318_79.doc @ 32203 @ 4  
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4.4.5.5. Editing Message main menu 
Messages can be confirmed/acknowledged, the last messages can 
be called up and the display of the messages can be switched on 
or off. 

 

1 Message text 
2 Additional information on 

the message 
3 Message number 

(example: "4/7" refers to 
the fourth of seven 
messages) 

4 Number of messages 
present (example: "4/7" 
refers to the fourth of 
seven messages) 

5 Message code (see 
Status, warning and 
error messages page 
37). 

  

 
Using the P2A software (see Parameterizing, adjusting and 
analyzing software (P2A software) page 42) you can 
predefine whether messages are to be shown in the 
display. 

 

1. In the Measuring Mode press SET, select Main Menu Message 
with  or  and confirm selection with SET. 

2. Confirm Confirm message using SET. 
3. Select Last messages with  or  and confirm with SET. 
4. Scroll between the warning and error messages recorded so far 

using  or  and return to Last messages using ESC. 
5. Select Information with  or  and confirm with SET. 
6. Scroll between the status messages recorded so far using  or 

 and return to Information using ESC. 
7. Continue to Display of message with  or . 

ON: Measurements are shown on the display in Measuring 
Mode. 
OFF: No messages shown on display. 

8. Select ON or OFF with  or  and confirm selection with SET. 
9. Return to Main Menu Message with ESC. 
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10. Continue to Main Menu Ident with  or  or return to 
Measuring Mode with ESC. 

 

 
An overview of the messages can be found in Status, 
warning and error messages page 37 

 
Pos: 52 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Ident abfragen 6781 @ 3\mod_1239269378840_79.doc @ 31053 @ 4 
 

4.4.5.6. Calling up Main Menu Ident 
 

1 Serial number  
2 Instrument type 
3 Build number 

 

4. Firmware 
version 

 

1. In the Measuring Mode press SET, select Main Menu Ident 
with  or  and confirm selection with SET. 

- The type, firmware version, build number and serial number of 
the transmitter are displayed. 

 

 
This information is required when servicing. 

 

2. Return to Main Menu Ident with ESC. 
3. Continue to Main Menu Adjust with  or  or return to 

Measuring Mode with ESC. 
Pos: 53 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Abgleich bearbeiten 6781 @ 3\mod_1239867127747_79.doc @ 31254 @ 455  

4.4.5.7. Editing Main Menu Adjust 
A reference value can be entered for the temperature (°C/°F) and a 
reference value can be entered for the dewpoint (°Ctd/°Ftd) for the 
1-point adjustment. Please refer to the description in Adjusting the 
analog output page 62. 
In addition, the analog outputs can be adjusted. Also see Analog 
output adjustment page 23 for instructions on how to do this. 

 
 

Enter reference value for 1-point adjustment 
Please also refer to Analog output adjustment page 23. 
1. In the Measuring Mode press SET, select Main Menu Adjust 

with  or  and confirm selection with SET. 
2. Select Reference value temp or Reference value Td with  

or . 
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3. Press SET, edit value: Scroll one digit to the right using  and 
increase value of digit by 1 using . Confirm with SET or abort 
entry with ESC. 

4. Continue to Analog Adj. Ch. 1 with  or . 
5. Continue with the adjustment of the analog outputs (see below, 

step 2) or press ESC to return to Main Menu Adjust. 

Performing analog adjustment 
Please refer to Analog output adjustment page 23.  
1. In the Measuring Mode press SET, select Main Menu Adjust 

with  or  and confirm selection with SET. 
 

 
Each channel is adjusted at three points in the analog 
range (at 10 %; 50 %; 90°% of the analog scale). 

 

2. Select Analog Adj. Ch. 1 with  or  and confirm with SET. 
3. Use  or  to select Adj. Point 1. 
4. Press SET. Read off multimeter display (e.g. 5601 mA) and 

enter this value in the user menu. Do this by scrolling one digit 
to the right using  and increasing the value of digit by 1 using 

. Confirm with SET or abort entry with ESC. 
5. Use  or  to select Adj. Point 2. 
6. Press SET. Read off multimeter display (e.g. 12,001 mA) and 

enter this value in the user menu. Do this by scrolling one digit 
to the right using  and increasing the value of digit by 1 using 

. Confirm with SET or abort entry with ESC. 
7. Use  or  to select Adj. Point 3. 
8. Press SET. Read off multimeter display (e.g. 18,401 mA) and 

enter this value in the user menu. Do this by scrolling one digit 
to the right using  and increasing the value of digit by 1 using 

. Confirm with SET or abort entry with ESC. 
9.  Return to Main Menu Adjust with ESC. 
10. Continue to Main Menu Reset with  or  or return to 

Measuring Mode with ESC. 
Pos: 54 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Reset bearbeiten 635x @ 3\mod_1238480830340_79.doc @ 30373 @ 4 
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4.4.5.8. Editing Reset main menu 
You can reset the factory settings for the following: 
• Instrument 
•  Min./max. values 

 

 
Resetting to the factory settings means resetting to the 
order specification, i.e. the specific condition at the time of 
supply to the customer. 

 

1. In the Measuring Mode press SET, select Main Menu Reset 
with  or  and confirm selection with SET. 

- Reset Device to factory settings is displayed. 
2. Select the setting to be reset using  or  and confirm 

selection with SET. 
- Reset Completed is displayed. 
3. Return to the reset setting with ESC or SET and return to Main 

Menu Reset with ESC. 
4. Continue to the Main Menu Channel 1 with  or  or return to 

Measuring Mode with ESC. 
Pos: 55 /TD/Überschriften/MUF/1.5 Status-, Warn- und Fehlermeldungen @ 3\mod_1234442925442_79.doc @ 24963 @ 2  

4.5. Status, warning and error messages 
Pos: 56 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Status-, Warn- und Fehlermeldungen _6781 @ 3\mod_1241441355544_79.doc @ 32477 @  
 

To achieve optimum operational reliability (machine availability), 
the transmitter shows the following via the user menu or the P2A 
software 
• Status messages 
• Warning messages 
• Error messages 
in each case for the testo 6781 transmitter. 
All messages are stored in the transmitter with an operating hours 
stamp. Use the user menu (see Editing Message main menu page 
34) or the P2A software (see Transmitter history page 63) to view 
the message history. 
In the transmitter, the last 60 status messages and the last 120 
error and warning messages are stored in a ring memory. There is 
no limit in the P2A software. 

Pos: 57 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Statusmeldungen 678x @ 3\mod_1238508288143_79.doc @ 30547 @ 3 
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4.5.1. Status messages 
Status messages show the current operating status of the testo 
6781. 

 

Message Display Description 
02506 Sensor 

initialization 
Message appears while the 
transmitter is starting up. If the 
message disappears, the 
transmitter is ready for operation. 

01D19 Service plug The Mini-DIN socket is connected 
to: the USB adapter for P2A 
software, the adjustment adapter 
or the service plug (is not 
recorded/no number) 

00300 New limit value The limit value has been changed 
or shifted 

00301 Scaling changed The scaling has been changed 
02104 Analog out adjust An analog adjustment has been 

made 
00500 Transmitter reset The transmitter was reset to the 

factory settings and is restarted. 
0052F Reset Min/Max Resets all saved Min/Max values 

for all channels 
00503 Reset device to 

fact 
A factory reset of the transmitter 
was performed 

00307 User Setting 
Change 

User Setting Change: General 
settings were changed for the 
transmitter 

 
Pos: 58 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Warnmeldungen 678x @ 3\mod_1238508265361_79.doc @ 30526 @ 3 
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4.5.2. Warning messages 
Warning messages show an early warning or a current malfunction 
which may negatively impact measuring. 

 

Message  Display Cause Remedying of fault 
00E00 T ambient high The ambient 

temperature exceeds 
the permissible 
temperature for the 
transmitter. 

Take necessary 
measures to lower 
ambient temperature, 
e.g. through venting or 
cooling. 

00E01 T ambient low The ambient 
temperature is below 
the permissible 
temperature for the 
transmitter. 

Take necessary 
measures to raise 
ambient temperature, 
e.g. through heating. 

00E02/00E
05 

Supply voltage 
low 

The supply voltage is 
below the minimum 
voltage required for the 
transmitter. 

Take measures to 
ensure sufficient 
voltage supply. 

0081C Alarm 1 Depending on the 
parameterization of the 
alarm. 

Depending on the 
parameterization of the 
alarm. 

0081D Alarm 2 Depending on the 
parameterization of the 
alarm. 

Depending on the 
parameterization of the 
alarm. 

0081E Alarm 3 Depending on the 
parameterization of the 
alarm. 

Depending on the 
parameterization of the 
alarm. 

0081F Alarm 4 Depending on the 
parameterization of the 
alarm. 

Depending on the 
parameterization of the 
alarm. 

 
Pos: 59 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Fehlermeldungen Messumformer 635x/6781 @ 3\mod_1236081613819_79.doc @ 27212 @ 3  
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4.5.3. Transmitter error messages 
Error messages show a current malfunction. 

 

Message  Display Cause Remedying of fault 
01505 Watchdog error Due to a processor 

error, the transmitter 
performs an automatic 
restart. 

If the problem occurs 
frequently, contact 
Testo Service. 

01115 Low adjustment 
temperature 

The ambient 
temperature is too low 
during the pressure 
adjustment. 

Take necessary 
measures to raise 
ambient temperature, 
e.g. through heating.  

01116 High adjustment 
temperature 

The ambient 
temperature is too high 
during the pressure 
adjustment. 

Take necessary 
measures to lower 
ambient temperature, 
e.g. through venting. 

 
Pos: 60 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Behandlung von Alarmmeldungen 678x @ 3\mod_1238508453754_79.doc @ 30589 @ 3 
 

4.5.4. Handling alarm messages 
 

Shown on the 
display4  

Can be used for 
collective alarm5 

Additional 
message end6 

New limit value x  
Scaling changed x  
Alarm 1  x 
Alarm 2  x 
Alarm 3  x 
Alarm 4  x 
Transmitter reset x  
Analog out adjust x  

                                                           
4 If multiple messages/alarms are activated at the same time, only the last 
message/alarm is shown. If this is cancelled, the other messages that are still 
active are no longer displayed. 
5 The message can be assigned the collective alarm function, which means that 
the collective alarm is activated as soon as at least one of the messages 
assigned to it is activated.  
6 The message is shown upon the occurrence of the event causing the message 
as well as when closing. Two entries appear in the history in the P2A software: 
Message text_start and Message text_end. 
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Shown on the 
display4  

Can be used for 
collective alarm5 

Additional 
message end6 

T ambient high x x 
T ambient low x x 
Supply voltage low x x 
Watchdog error x  

 

Perform the Confirm message function (acknowledgement of the 
alarm via the control keys on the transmitter): 
• The message/alarm is no longer shown on the display and the 

optical alarm goes out, where applicable. If multiple 
messages/alarms are active at the same time, all are reset 
simultaneously. 

• If at least one message is assigned to the collective alarm, the 
collective alarm is reset.  

Pos: 61 /TD/Überschriften/MUF/1.6 Wartung und Reinigung @ 3\mod_1234443039129_79.doc @ 24982 @ 2  

4.6. Maintenance and cleaning 
Pos: 62 /TD/Produkt instand halten/MUF 63xx/Gerät warten/reinigen 6781 @ 4\mod_1244646493414_79.doc @ 44985 @ 33 
 

4.6.1. Maintaining the instrument 
We recommend that the adjustment and settings of the transmitter 
be checked at regular intervals using the 
• User menu (Operation page 24) or 
• P2A software (Parameterizing, adjusting and analyzing software 

(P2A software) page 42) 
  

4.6.2. Cleaning the instrument 
• Only clean the instrument carefully with a moist cloth. 
• Do not use aggressive cleaning agents. 
• Do not use any solvents. 
• Do not touch or damage the sensor. 

Pos: 63 /TD/Produkt instand halten/MUF 63xx/Messkammer, Abkühlstrecke, Sensor @ 3\mod_1238508590396_79.doc @ 30610 @ 55 
 

Protection cap, measurement chamber, cooling coil 
If used in process conditions involving oil or dust, the protection cap 
and, if used, the measurement chamber and cooling coil must be 
cleaned regularly. 
•  Unscrew/remove protection cap, measurement chamber and 

cooling coil and blow out with compressed air or place in an 
ultrasonic bath. 
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•  Replace a heavily soiled protection cap with the same type of 
protection cap. 

 

 
The accuracy is only maintained when the ordered 
protection cap is replaced by the same type of protection 
cap. 

 

Sensor cleaning 
 

 
During sensor cleaning, avoid any contact with the sensor. 

  

 
Do not mechanically clean the sensor, as otherwise the 
cover electrode may be damaged. 

 

1. Carefully unscrew protection cap. 
2. Carefully rinse with isopropanol and/or distilled water. 
3. Allow sensor to dry thoroughly. 
4. Screw on protection cap. 

Pos: 64 /TD/Überschriften/MUF/3 Parametrier-, Abgleich und Analysesoftware (P2A-Software) @ 3\mod_1234258523713_79.doc @ 23932 @ 1  

5 Parameterizing, adjusting and analyzing 
software (P2A software) 

Pos: 65 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

5.1. Specifications 
Pos: 66 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 63xx P2A @ 3\mod_1234258967326_79.doc @ 24065 @ 355 
 

The P2A software is used for the parameterizing, adjustment and 
analysis of testo transmitters. The following applies: 
• Generally, all newer testo transmitters (as of 2007) are 

supported. 
• Included with every testo transmitter that is bought new is a CD 

that contains a free upgrade of the software, which includes the 
device drivers for all transmitters that can be attached at this 
time. 

• This upgrade can be downloaded at any time via the testo 
homepage "www.testo.com/Download/P2A". 

The software must only be bought one time, even for owners of 
several testo transmitters. 
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5.1.1. Functions and use 
In the P2A software, two different file types are used: The 
instrument and the parameter file. 

Instrument file 
The parameters of a particular transmitter are stored in its so-called 
instrument file. Using this file, the parameters can be edited and the 
instrument can be tested and adjusted. 
Instrument files also contain the respective histories in addition to 
the parameter data, i.e. "log books" are kept for the previous 
parameterizations, adjustments and messages (see Transmitter 
history page 63). 

 

 
Instrument files are ".cfm" format files. 

 

Parameter file 
Parameter files are not tied to a specific individual transmitter and 
contain only parameter data/no history data. 
If you use various instruments of the same type, you can create 
parameter files once (e.g. by saving the appropriate instrument file 
as the parameter file) and transmit these onto the other 
instruments. 

 

 
Parameter files are ".cfp" format files. 

 
Pos: 67 /TD/Leistungsbeschreibung/Systemvoraussetzungen/MUF 63xx @ 3\mod_1234260654399_79.doc @ 24084 @ 3555  

5.1.2. System requirements 
Operating system 
• Windows® 2000 SP4 
• Windows® XP Home/Professional 
• Windows® Vista 

Computer 
• Pentium processor of at least 400 MHz or equivalent 
• 128 MB RAM 
• Graphics resolution of at least 1024 x 768  
• Unused hard drive capacity of at least 15 MB 
• CD-ROM drive 
• USB interface 
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• At least Internet Explorer 5.0. 

Software 
The P2A software must be purchased and installed separately from 
the transmitter. If it is a new software version, the transmitter is 
already supported completely. Older P2A software versions can be 
updated via the P2A software upgrade (cf. product CD included 
with the transmitter). 

Pos: 68 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 63xx P2A @ 3\mod_1234260991646_79.doc @ 24103 @ 3 
 

5.1.3. Scope of delivery 
Included in the scope of delivery are: 
• P2A software 
• USB driver 

 

 
When working with the parameterizing, adjusting and 
analyzing software (P2A software), previous knowledge of 
Windows® operating systems is assumed. The description 
in this instruction manual relates to Windows® XP. 

 
Pos: 69 /TD/Überschriften/MUF/3.2 Erste Schritte @ 3\mod_1234258633304_79.doc @ 23970 @ 2 
 

5.2. First steps 
Pos: 70 /TD/Erste Schritte/MUF 63xx/P2A/Software/Treiber installieren @ 3\mod_1234261192065_79.doc @ 24123 @ 3444 
 

5.2.1. Installing the software/driver 
 

 
Administrator rights are required to install programs and 
drivers under Windows® 2000 SP4, XP and Vista. 

 

5.2.1.1. Installing P2A software 
1. Insert CD with P2A software.  

✓  If the installation program does not start automatically: 

> Open Windows Explorer and start the file Setup.exe on the 
product CD. 

2. Follow the directions of the installation wizard. 

5.2.1.2. Installing USB driver 
 

 
Before installing the USB driver, please read the separate 
documentation that is enclosed with the USB driver CD. 
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5.2.1.3. P2A software upgrade 
1. Insert product CD (supplied with the transmitter). 
2. Open Windows® Explorer and start the file P2A upgrade.exe 

on the product CD. 
3. Follow the directions of the installation wizard. 

Pos: 71 /TD/Erste Schritte/MUF 63xx/P2A/Software starten @ 3\mod_1234261605199_79.doc @ 24142 @ 3444 
 

5.2.2. Starting the software 
5.2.2.1. Starting the program 

> Select: [Start] > All Programs > Testo > P2A Software. 
- The program window is opened (see User interface page 46). 

5.2.2.2. Establishing a connection with the instrument 
Multiple instruments can be attached, however only one connection 
is active at all times. 

✓  USB driver is installed (see Installing USB driver page 44). 

1. Start the P2A software. 
2. Connect adapter (supplied with the P2A software) to the service 

interface of the instrument (see Service interface page 16). 
3. Connect instrument/adapter to the PC via the USB interface. 
- The instrument file of the attached instrument is shown in the 

file list. 

5.2.2.3. Activating the connection with the instrument 
> Click on the desired instrument file. 
- The selected file is marked in colour and the connection with 

the instrument is activated. 
If a connection with the instrument is established when the program 
is started, the corresponding instrument file is marked 
automatically. 
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Pos: 72 /TD/Überschriften/MUF/3.3 Software verwenden @ 3\mod_1234258679599_79.doc @ 23989 @ 2 
 

5.3. Using the software 
Pos: 73 /TD/Produkt verwenden/MUF 63xx/P2A/Software verwenden @ 3\mod_1234262654547_79.doc @ 24162 @ 3  

5.3.1. User interface 
 

  

1 Menu bar: 
 

Menu  Command  Explanation 
File Open Shows the Windows dialogue for 

searching and opening files. 
 Save as Saves the parameters of an 

instrument or parameter file 
under a new name. 

Edit Copy Copies the parameters of the 
marked instrument or parameter 
file in the cache. 

 Paste Pastes the parameters from the 
cache in the marked instrument 
or parameter file. 

View Toolbar 
Status bar 

Activates/deactivates the toolbar 
or status bar. 
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Menu  Command  Explanation 
? Check instrument 

connections 
Checks the connections to a 
connected instrument without the 
instrument having to be 
activated. 

 Service A text file with the most important 
information on the computer and 
the software is opened via 
Display service data. 

 Information Shows the version number of the 
P2A software. 

 
 
 

2 Toolbar: Shows the Windows-compliant icons for editing. 
3 File: 

 

Icon  File Explanation 

 
Symbol shows a 
transmitter 

Instrument 
file 

Instrument file 
Connection to the instrument has 
been established. 
<Type> <Serial number>.cfm 
File name should not be 
changed. 

 
Symbol shows a 
transmitter with a red 
minus sign in the upper 
left corner 

Instrument 
file 

Instrument file 
Connection to the instrument has 
not been established. 

 
Symbol shows a 
transmitter with a white 
P for parameter file in 
the upper left corner 

Parameter 
file 

<Type> <Serial number> 
<Date> <Time>.cfp 
File name can be changed. 
The name can be selected freely, 
but it is recommended that you 
retain the reference to the 
instrument. 
Parameter files are always 
marked red; the parameter 
values they contain are only 
forwarded to the instrument after 
being transmitted to the 
instrument file. 



5 Parameterizing, adjusting and analyzing software (P2A software) 

48 

 

4 Function buttons: Dialogues on editing and testing the 
instrument are opened by means of the buttons. 

[Change parameterization] see Changing instrument/parameter 
file page 48  
[Test/analyze transmitter] see Chapter Analyzing/testing the 
transmitter page 57 
[Adjusting the transmitter] see Chapter Adjusting the transmitter 
page 60  
[Transmitter history] see Transmitter history page 63  
5 File information: 

 

Status  Shown in the window  
An instrument file is 
selected 

Type, serial number, firmware version of the 
instrument. 

A parameter file is 
selected 

Type, serial number and firmware version of 
instrument for which the parameter file was 
created. 

Connection status Green = connection is active 
Red = connection is inactive 

 

6 Status bar: Shows the current status when editing via the menu 
bar. 

Pos: 74 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei bearbeiten @ 3\mod_1234358080444_79.doc @ 24303 @ 34 
 

5.3.2. Editing instrument/parameter file 
5.3.2.1. Changing instrument/parameter file 

✓  The desired instrument/parameter file is marked. 

1. Click on [Change parameterization]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Change parameterization register. 
If the parameters were transmitted from other parameter files into 
the instrument file, a message is shown with which you can 
transmit the new parameters to the connected instrument using 
[Yes]. 

> If the parameters should not be transmitted, click on [No]. 
2. Change or enter parameters in the corresponding fields. 

Pos: 75 /TD/Produkt verwenden/MUF 63xx/P2A/Einheit / Analogausgang ohne Relais @ 4\mod_1244205188941_79.doc @ 44503 @   
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Field Explanation 
Unit/ 
Analog output 

All analog outputs are parameterized in this 
mask. 

Unit/analog output 
(graphic) 

Unit: 0 to 1 V/5 V/10 V or 0...20 mA, 4 to 20 
mA. 
Vertical: Current version of the analog output 
(cannot be changed). 
Horizontal: Min./max. scale end points of 
selected unit. 
The curve changes in accordance with the 
entered value of scale minimum and 
maximum. 

Scale minimum/ 
maximum 

The endpoints of the scaling can be selected 
up to the stored scale minimum and 
maximum. In the process, scaling can take 
place beyond the measuring range in order 
to adjust the analog output to the customer 
system.  

Unit Selection of the physical unit. 
When changing the unit, standard values are 
set for scale minimum and maximum. 

Signal delay 
(graphic) 

Curve changes according to the set signal 
delay. 
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Field Explanation 
Signal delay Time interval in stages 1 – 15: 

1 = no delay 
15 = longest delay. 
The signal delay is added to the reaction time 
of the sensor. The signal delay shows 
averaging over the time interval of the 
selected stage in seconds: 
Example 
Stage 10 = average of the readings from the 
last 10 seconds. 

  

 
The delay of the signal in relation to the change in the 
process is also significantly influenced by the selection of 
the particle filter. 

 
Pos: 76 /TD/Produkt verwenden/MUF 63xx/P2A/Grenzwerte Relais 6781 @ 4\mod_1250579466639_79.doc @ 47463 @   

Field  Explanation 
Alarm values, alarm 1 to 4 In this mask, the display alarms 

are parameterized. 

 
Alarm x Four alarm values are available. 
Not used Alarm is not used. 

Hysteresis image and input 
options are hidden. 
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Field  Explanation 
Collective alarm If selected messages appear, a 

collective alarm can be triggered. 
Selection of the messages (OR 
linkage) by selecting the 
checkbox. 

Min control If switched to ON (NO contact) or 
OFF (NC contact) under the limit 
value; in the event of a 
subsequent exceeding of Limit 
value plus Hysteresis, it is 
switched to OFF (NO contact) or 
ON (NC contact). 

Max control If switched to ON (NO contact) or 
OFF (NC contact) above the limit 
value; in the event of a 
subsequent undershooting of 
Limit value minus Hysteresis, it 
is switched to OFF (NO contact) or 
ON (NC contact). 

  

 
The graphic display in the centre of the screen refers to 
the relay wiring as a NO contact (ON). 

  

Hysteresis To avoid switching cycles. 
Channel Selection of the channel that is to 

be monitored. 
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Field  Explanation 
Limit value Values for the limits of the unit 

selected in Unit/analog output; 4 
decimal places. 
When changing the phys. unit, the 
limit values are set to the default 
values. 

Visual alarm display Checkbox is activated: Upon the 
appearance of the selected alarm, 
the background lighting of the 
display flashes. 

Response delay The desired response delay for 
the alarms of the min/max control 
and the visual alarm is entered in 
the input field (0 to 240 seconds 
possible).  
The response delay has no effect 
on the collective alarms. 

 
Pos: 77 /TD/Produkt verwenden/MUF 63xx/P2A/Grundeinstellungen 6781 @ 4\mod_1244205730179_79.doc @ 44535 @  
 

Field  Explanation 
Basic settings Setting the absolute pressure. 
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Field  Explanation 
Absolute pressure The absolute pressure is included in the 

calculation of the following units: 
• °Ctd or °Ftd 
• g/kg or gr/lb 
• ppm (vol) 

 
Pos: 78 /TD/Produkt verwenden/MUF 63xx/P2A/Display @ 3\mod_1234424330866_79.doc @ 24673 @   

Field  Explanation 
Display Setting the display functions (if a display is 

available on the transmitter). 

Continuous display 
lighting 

Display lighting is permanently switched on. 

Display lighting 
when button is 
pressed 
(10 seconds) 

When a particular button on the instrument is 
pressed, the display lights up for 10 seconds.

Display brightness 
(0 to 9) 

Setting the brightness between 0 and 9: 
0 = dark 
9 = light 

Display contrast 
(0 to 9) 

Setting the contrast between 0 and 9: 
0 = low contrast 
9 = high contrast 
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Field  Explanation 
Display of the error 
messages 

Selection of whether the error messages 
should be shown in the display. 

Display language Selection of the language. 
New password The password consists of four numbers, 

each of which must be between 1 and 9.  
If the password protection is not to be used, 
the numerical code "0000" must be entered. 

[Adopt new 
password] 

Button for confirming the new password. 

Valid password Display of the current password. 
 
Pos: 79 /TD/Produkt verwenden/MUF 63xx/P2A/Selbstabgleich 6781 @ 4\mod_1244444184402_79.doc @ 44673 @ 5  

Field  Explanation 
Self-adjustment Setting the self-adjustment. 

 
Activate self-
adjustment for 
transmitter 

• Checkbox is activated: The self-
adjustment is performed in the set cycle.  

• Checkbox is not activated: The self-
adjustment is not performed. 
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Field  Explanation 
Cycle time Setting the cycles in which the self-

adjustment is to be performed: 
• 1 hour 
• 7 hours 
• 12 hours 
• 24 hours 

  

 
In order to receive reliable readings 
during the calibration or equalization 
period of the transmitter, testo 
recommends the shortest possible 
cycle time.  
A longer cycle time can be set in 
continuous operation. 

   
Start self-
adjustment 
manually 

Manually start the self-adjustment at the 
defined point in time outside of the cycle time 
by pushing the button. 

Pos: 80 /TD/Produkt verwenden/MUF 63xx/P2A/Gerätedatei erzeugen @ 3\mod_1237206865717_79.doc @ 29703 @ 4  

5.3.2.2. Creating a new instrument file 
It is possible to create an instrument file without restarting the P2A 
software. 

✓  Transmitter must be connected. 

1. Click on File > New connection in the menu bar. 
- Connection to the transmitter is established. 

Pos: 81 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter speichern @ 3\mod_1234358425697_79.doc @ 24322 @ 4 
 

5.3.2.3. Saving parameters 
Parameters can be saved in new parameter files. 
1. Mark instrument/parameter file. 
2. Click on File > Save as in the menu bar. 
3. Select storage location and enter the file name. 
4. Click on [Save]. 
- The new parameter file is shown in the file list. 
Only the parameters are saved from an instrument file; the history 
data are not adopted. 
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The original name (Instrument type, Serial number) is 
suggested with the current date/time as standard, e.g. 
"testo 6781 01234578 061120 1403.cfp". 
For a standard installation, the files are saved under 
"C:\Documents and Settings\All Users\Shared 
Documents\P2A Software". The path can differ depending 
on the version of the operating system. 

 
Pos: 82 /TD/Produkt verwenden/MUF 63xx/P2A/Parameterdatei öffnen @ 3\mod_1234358634164_79.doc @ 24341 @ 4  

5.3.2.4. Opening the parameter file 
All parameter files stored in the standard directory path are 
automatically displayed in the file list when the software is started. 
You can also open parameter files that are stored in other 
directories. 
1.  Click on File > Open in the menu bar. 
2. Select the storage location and click on the requisite file. 
3. Click on [Open]. 
- The selected file is opened. This can be changed and saved 

(see Editing instrument/parameter file page 48). 
Pos: 83 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter kopieren/einfügen @ 3\mod_1234358826054_79.doc @ 24360 @ 4  

5.3.2.5. Copying and pasting parameters 
The parameters of a parameter file can be transmitted to an 
instrument file or another parameter file from the same instrument 
type. 
1. Select file from which parameters are to be copied. 
2. Click on Edit > Copy in the menu bar. 
3. Select the file which is to be modified. 
4. Click on Edit > Paste in the menu bar. 
- The parameters are transmitted to the file. 

 

 
You can also use the common keyboard shortcuts for 
copying (CTRL+C) and pasting (CTRL+V). 
Parameters can also be transmitted using drag & drop, 
where you drag the icon of the parameter file onto the icon 
of the target instrument file. 

 

5. Connect and select corresponding instrument. 
6. Click on [Change parameterization]. 
7. Confirm confirmation request. 
- Parameter data are transferred to the instrument. 
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 Pos: 84 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei löschen @ 3\mod_1234359025194_79.doc @ 24379 @ 4 
 

5.3.2.6. Deleting instrument/parameter file 
Instrument/parameter files can be deleted from the file list. 
1. Click on the file that is to be deleted with the right mouse button. 
2. Select the command Delete in the context menu. 
- The instrument or parameter file is deleted from the list. 

Pos: 85 /TD/Überschriften/MUF/x.x.x Messumformer analysieren / testen @ 3\mod_1237380874787_79.doc @ 29928 @ 3 
 

5.3.3. Analyzing/testing the transmitter 
Pos: 86 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer analysieren/testen _6781 @ 4\mod_1244213023929_79.doc @ 44639 @ 4  

In this section, you can test the outputs of the connected 
instrument, read off the limit values and reset the parameters to the 
factory settings. 
The function is only available for instrument files. 

5.3.3.1. Analyzing/testing the instrument 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Perform action: 

 

Action  Explanation 
Carrying out factory 
reset 

Reset the unit, limit value and hysteresis 
parameters to factory settings (see below). 

Testing analog 
output 

Test channel 1 (see Testing analog output 
page 58). 

Display min./max. 
values 

Overview of the minimum and maximum 
values measured since the last reset of the 
transmitter (see Displaying min./max. values 
page 59). 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 87 /TD/Produkt verwenden/MUF 63xx/P2A/Werksreset durchführen @ 3\mod_1237379864072_79.doc @ 29887 @ 4 
 

5.3.3.2. Carrying out factory reset 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark transmitter test. 
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- Current operating hours are shown. 
3. Confirm control query to perform the reset. 
- The values are reset to the customer-specific factory settings. 
4. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 88 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang testen _6781 @ 3\mod_1241448537872_79.doc @ 32540 @ 4 
 

5.3.3.3. Testing analog output 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark channel and test values. 

 

Field/button Explanation 
 Check the analog outputs (see Testing 

functionality of analog outputs page 
32). 

 
Current reading Readings are updated every second. 
Unit Unit according to the type of analog 

output. 
Default value Freely definable output value for the 

respective type of analog output (V or 
mA), 1 decimal place. 
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Field/button Explanation 
[Activate] The entered default value is forwarded 

to the corresponding analog output 
and to the test contacts by clicking. 
A warning informs that the value is 
being transmitted to the connected 
instrument in the event of existing 
cabling. 
Now check the analog output using a 
precise multimeter. 

[Deactivate] Finish entering the electrical variables 
at the analog output. 
The analog output returns to the 
current reading again. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output returns to Measuring Mode again. 

Pos: 89 /TD/Produkt verwenden/MUF 63xx/P2A/Min-/Max-Werte anzeigen 635x @ 3\mod_1242135985269_79.doc @ 32803 @ 4 
 

5.3.3.4. Displaying min./max. values 
The transmitter saves the minimum or maximum value for each 
channel (measured since the last voltage supply or since the last 
manual reset). 

✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Min./max. values. 

 

Field/button  Explanation 
Min./max. values View the min./max. values of each channel. 

Only the values within the measuring range 
are shown. 
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Field/button  Explanation 

 
Channel Channel 1 min./max. 
Value Min. or max. value, 1 decimal place. 
Unit Unit selected in Unit/analog output. 

 

3. Reset Min./max. values. 
4. Click on [Reset min./max. values]. 
5. Confirm control query to perform the reset. 
- The values are reset to the factory settings. 
6. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 90 /TD/Überschriften/MUF/x.x.x Messumformer abgleichen @ 4\mod_1244530152797_79.doc @ 44885 @ 3 
 

5.3.4. Adjusting the transmitter 
Pos: 91 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer abgleichen 6781 @ 3\mod_1241447656216_79.doc @ 32519 @   

This function is used to adjust an attached instrument. The 
following adjustments may be carried out using the software: 
• 1-point adjustment (offset) 
•  Analog adjustment (entry via assistant/wizard) 
Also see Adjusting the instrument page 21 

Pos: 92 /TD/Produkt verwenden/MUF 63xx/P2A/1-Punkt-Abgleich 6781 @ 3\mod_1241448954095_79.doc @ 32561 @ 4 
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5.3.4.1. 1-point adjustment 
 

 
A dew mirror hygrometer is recommended as the reference 
measuring instrument for the 1-point adjustment (offset). 

 

1. Expose the reference measuring instrument and the instrument 
to be adjusted to the same constant conditions and wait for 
equalization period to lapse. 

2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Enter reference value and click on [Carry out 1-point 

adjustment]. 
5. Confirm confirmation request. 
- The adjustment is carried out. 

 

Field  Explanation 

°Ctd/°Ftd Selection of the unit; only for dewpoint 
adjustment. 

°C/°F Selection of the unit; only for temperature 
adjustment. 

Current reading Reading in the selected unit °Ctd/°Ftd or °C/°F. 
Readings are updated every second. 
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Field  Explanation 
Reference value Entry of the read-off value from the reference 

measuring instrument. 
Permissible entries: 
• max. 10 °Ctd deviation (sum of all 1-point 

adjustments) 
• max. 2 K (°C) deviation (sum of all 1-point 

adjustments) 
 

> Click on [Set offset to zero] to reset a transmitted reference 
value. 

- The current reading is used again. 
6. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 93 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang abgleichen _6781 @ 3\mod_1241426828850_79.doc @ 32386 @ 4  

5.3.4.2. Adjusting the analog output 
1. Connect precision multimeter (see Analog output adjustment 

page 23). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 
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Field Explanation 

Default value The analog output value from the last 
performed adjustment is given at the output. 
Value of the factory adjustment: 
• Lower adjustment point: approx. 10 % of 

the max. value 
• Centre adjustment point: approx. 50 % of 

the max. value 
• Upper adjustment point: approx. 90 % of 

the max. value 
Measured analog 
value 

Required field: Entry of the value read off at 
the multimeter. 

 
Pos: 94 /TD/Überschriften/MUF/2.3.5 Messumformer-Historie @ 3\mod_1237373806926_79.doc @ 29846 @ 3  

5.3.5. Transmitter history 
Pos: 95 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer-Historie 6781 @ 4\mod_1244209291490_79.doc @ 44567 @  
 

Parameterizations, adjustment processes and messages that have 
occurred are registered in the transmitter with an operating hours 
stamp. 
In the history overviews (explained later in more detail), past 
processes and events can be made visible. 
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For parameter changes or adjustments that are performed 
directly at the instrument (via the user menu), "Transmitter" 
is entered in the User field and only the operating hour is 
entered in the Date/time field instead of operating 
hour/date/time. 
For entries that are performed using the P2A software, the 
name of the user logged into Windows appears in the User 
field, while the date/time and operating hour are shown in 
the Date/time field. 

 

1. Mark the instrument file of the connected instrument. 
2. Click on the [Transmitter history] button. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Transmitter history register. 
3. Click on the required entry in the list to change the display. 

 

Field Explanation 

 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Comments Type of parameter change, e.g. "Unit of 
channel 1 from % RH to Ctpd". 
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Field Explanation 

Selection of adjustment histories: 1-point adjustments / Analog 
adjustments. 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Reference value Value read off at reference instrument. 

Unit Unit during the adjustment. 

Actual value before 
adjustment 

1-point adjustment: Reading of the 
transmitter. If no changes were performed, 
no value is displayed. 

Offset from 1-point adjustment: Value before the 
adjustment. 

Offset to 1-point adjustment: Value after the 
adjustment. 

Channel Analog adjustment: Channel 1. 

Specification Analog adjustment: Actual value. 

Reading Analog adjustment: Entered reference value.
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Field Explanation 
Offset Analog adjustment: Deviation at time of 

adjustment. 

 
The table is shown only for error and status messages that were 
generated in the transmitter and were transferred and saved there 
via the connection to the P2A software. 
Operating hours Operating hour at which the message 

appeared in the instrument. 
Serial number Serial number of the instrument to which the 

message is assigned 
Message e.g. "Scaling changed". The scaling was 

changed. 
Type of message e.g. early warning, status message. 

 

> To print out the history data, click on [Print]. 
 

 
The printing job is automatically sent to the default printer 
for the operating system. 
With [Set up printer …] a different printer can be selected 
or the printout can be edited. 

 

4. Click on [OK] or [Cancel] to close the dialogue. 
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Pos: 96 /TD/Überschriften/8. Tipps und Hilfe @ 0\mod_1173789887985_79.doc @ 406 @ 1 
 

6 Tips and assistance 
Pos: 97 /TD/Überschriften/8.1 Fragen und Antworten @ 0\mod_1177402017078_79.doc @ 1093 @ 2  

6.1. Questions and answers 
Pos: 98 /TD/Tipps und Hilfe/Fragen und Antworten/MUF 6781 @ 3\mod_1239863529560_79.doc @ 31233 @  
 

Question Possible causes/solution 
Connection to instrument 
cannot be established 

Check connection cable/plug contacts

Reading is too high or too 
low 

• There is still no equilibrium 
condition in the system. 

• Clean sensor or sintered cap, see 
Maintenance and cleaning page 41

A message appears on the 
display 

See Status, warning and error 
messages page 37 

Malfunction (with and 
without display) 

Analysis using the P2A software, see 
Analyzing/testing the transmitter page 
57  

Undo adjustment A 1-point temperature/humidity 
adjustment can be reset to the current 
readings using [Set offset to zero] 
The actual values before the 
adjustment can be read out from the 
corresponding history table. 

 

If we could not answer your question, please contact your dealer or 
Testo Customer Service. For contact details see the rear side of 
this document or the web page www.testo.com/service-contact 

Pos: 99 /TD/Überschriften/8.2 Zubehör und Ersatzteile @ 0\mod_1177402058734_79.doc @ 1102 @ 2  

6.2. Accessories and spare parts 
Pos: 100 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Zubehör Ersatzteile MUF 678x @ 3\mod_1238504299533_79.doc @ 30505 @   
 
 

Description  Article no. 
Measurement chamber and cooling coil  
Precision measurement chamber up to 
35,000 hPa with adjustable inflow 

0554 3312 

Cooling coil for process temperatures above 
50 °C (up to 200 °C), only with measurement 
chamber 

0554 3304 

Preliminary filter 0554 3311 
Flow indicator 0554 3313 
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Description  Article no. 
Measurement chamber and cooling coil  
Precision measurement chamber up to 
35,000 hPa with adjustable inflow 

0554 3312 

Cooling coil for process temperatures above 
50 °C (up to 200 °C), only with measurement 
chamber 

0554 3304 

Preliminary filter 0554 3311 
Flow indicator 0554 3313 
Interface and software  
P2A software (parameterizing, adjusting, 
analyzing) incl. USB adapter 

0554 6020 

Plug-in connections  
M12 plug-in connection (socket) for power 
and signal lines 

0554 6689 

Supply  
Mains unit (desktop, wall-mounted) 0554 1748 
Mains unit (top-hat rail mounting) 0554 1749 
Hose  
PTFE tube with compressed air connections, 
2 m, up to 140 °C and max. 9000 hPa 

0699 2824/4 

External display  
Process display for testo 54-2 AC.... 5400 7553 
Process display for testo 54-7 AC.... 5400 7555 
Calibration  
Standard ISO calibration certificate for 
dewpoint  
(-40 °Ctp to 0 °Ctp at 6000 hPa), freely 
selectable points  

0520 0116 

Standard DKD calibration certificate for 
dewpoint at -10 °Ctp and -40 °Ctp 

0520 0136 

For a complete list of all accessories and spare parts, please refer 
to the product catalogues and brochures or look up our website at: 
www.testo.com 
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Pos: 101 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Bestelloptionen MUF 6781 @ 3\mod_1239270048266_79.doc @ 31074 @ 3  

6.2.1. Ordering options for testo 6781 transmitter (0555 
6781) 

 

Order code  Characteristic 
Axx Process 
connection 

 

A01 Process connection G1/2 
A02 Process connection NPT 1/2" 
Bxx Analog 
output/supply 

 

B02 0 to 1 V (4-wire, 24 V AC/DC) 
B03 0 to 5 V (4-wire, 24 V AC/DC) 
B04 0 to 10 V (4-wire, 24 V AC/DC) 
B05 0 to 20 mA (4-wire, 24 V AC/DC) 
B06 4 to 20 mA (4-wire, 24 V AC/DC) 
Cxx Display  
C00 Without display 
C02 With display/English 
C03 With display/German 
C04 With display/French 
C05 With display/Spanish 
C06 With display/Italian 
C07 With display/Japanese 
C08 With display/Swedish 
Fxx Humidity variable  
F01 °Ctd/Min/Max 
F02 °Ftd/Min/Max 
F03 % RH/Min/Max 
F04 % RH/Min/Max 
F05 °CtdA/Min/Max 
F06 °FtdA/Min/Max 
F07 ppm (vol)/Min/Max 
F08 g/m3 /Min/Max 
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Order code  Characteristic 
F09 gr/ft3 /Min/Max 
F10 g/kg /Min/Max 
F11 gr/lb /Min/Max 
Kxx Languages of 
instruction manual 

 

K01 German/English instruction manual 
K02 French/English instruction manual 
K03 Spanish/English instruction manual 
K04 Italian/English instruction manual 
K05 Dutch/English instruction manual 
K06 Japanese/English instruction manual 
K07 Chinese/English instruction manual 
K08 Swedish/English instruction manual 
Mxx Protection cap7  
M01 Protection cap made of stainless steel 
M03 Protection cap made of PTFE 

C 
=== Ende der Liste für Textmarke Inhalt === 

                                                           
7 The accuracy is only maintained when the ordered protection cap is replaced 
by the same type of protection cap in the event of heavy soiling. 

IHW
TE-Logo-New-(Hi-Res)Clean

http://www.tequipment.net
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